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Preface

Overview

This manual describes how to install and use the clearVISN™ DECNIS 
Configurator (referred to throughout the manual as the configurator). It 
describes how to use the configurator to configure a DECNIS, to set up a 
PC as a load host, and to load the DECNIS from a PC using the 
configurator.

In addition, it describes how to load a configuration, created on a PC using 
the configurator, from an OpenVMS system using MOP.

Audience

This manual is intended for network managers.

The manual assumes that you understand and have some experience of:

• IBM®-compatible Personal Computers running Microsoft Windows 
95® or Microsoft NT™. 

• The DEC™ Network Integration Server (referred to throughout this 
manual as the DECNIS).

Associated Documentation

Product Documentation
• DECNIS Management (Volumes 1 and 2)

• DECNIS Introduction and Glossary

• DECNIS Installation and Configuration

• DECNIS Problem Solving (supplied on line as a Windows Help file)
 vii



• DECNIS Event Messages (supplied on line)

• DECNIS Release Notes (supplied on line)

Related  Documentation
• clearVISN DECNIS Configurator online help

• NCL online help for Microsoft Windows

• DTF User Guide

Returning Comments About this Documentation
We would like to know what you think about the DECNIS documentation 
set and online help.

If you have any comments, or suggestions, please return them in any of the 
following ways:

• Send an electronic mail message to the Internet address
books@reo.mts.dec.com

• Send an electronic mail message to the X.400 address S=IDC BOOKS; 
O=digital; OU1=reo; P=digital; A=CWMail; C=gb

• Send a fax to (+44) 118 920 6018

Conventions
The following conventions are used in the manual:

Italics This indicates variable information

DECNIS DEC Network Integration Server
viii



Chapter 1

Introduction

 1.1   Overview

This chapter describes the clearVISN DECNIS Configurator, referred to 
throughout this manual as the configurator.

 1.1.1  What Is the clearVISN DECNIS Configurator?
The configurator is a software application that enables you to:

• Create and modify the DECNIS configuration

• Load the DECNIS configuration and system image

• Create and load a Secure Connections configuration (see Chapter 4)

• Issue interactive NCL commands to a running DECNIS

The configurator uses a graphical user interface. You enter information 
about a DECNIS configuration on tab pages for the various DECNIS 
features you require. 

 1.1.2  Requirements
The configurator runs on an IBM®-compatible personal computer (PC) 
running Windows NT™ or Windows 95®.

 1.2   What DECNIS Functions Are Supported?

You can use the configurator to configure the following DECNIS functions:

• All DECNIS data links

• IP routing:

— Integrated IS-IS

— OSPF
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— RIP

• IP switching

• Route propagation and filtering

• DECnet Phase IV routing

• DECnet Phase V/OSI routing

• IPX routing

• Bridging (including address and protocol filtering)

• X.25 gateway and relay functions

• Database sizing

• Secure connections

This version of the configurator does not support AppleTalk® routing.
1-2  Introduction



 1.3   Overview of Configurator Tasks

To use the configurator to create and load  DECNIS configurations, carry 
out the following steps:

Procedure For more 
information, see ...

1 Install the configurator Chapter 2

2 Start the configurator Chapter 3

3 Enter address mapping information, if 
required

Chapter 7

4 Configure the DECNIS functions you 
require

Chapter 3

5 Create the load files Chapter 5

6 Configure the PC as a BOOTP load host 
or configure MOP loading from an 
OpenVMS load host 

Chapter 5

Chapter 6

7 Trigger the DECNIS to reboot Chapter 5
Introduction 1-3





Chapter 2

Installing the clearVISN DECNIS
Configurator

 2.1   Overview

This chapter describes the hardware and software required to install the 
configurator, and describes the installation procedure.

 2.2   Requirements for Installing and Running the 
Configurator

Table  2-1: Installation Requirements

PC hardware required Intel®-based 80486  or Pentium® PC, or 
Alpha-based PC running Windows NT 
V4.0, under FX!32 V1.1. Clock speed 
exceeding 33 MHz. The PC must also 
have the following:

• Memory: at least 8 Mbytes on 
Windows 95; at least 16 Mbytes on 
Windows NT

• VGA or better monitor

• LAN network adapter (Token Ring or 
Ethernet)

• CD-ROM drive (if installing from CD-
ROM)

• Mouse compatible with Windows NT 
or Windows 95
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 2.3   Installing the Configurator

 2.3.1  Before You Begin
Before you install the configurator, close down all unnecessary applications 
on your PC.

Consider where you wish to store the configurations you create. You can 
choose to keep them on a remote system, provided you create the necessary 
network drive on the PC. For example, you may wish to keep the files on 
an OpenVMS or Digital UNIX system, to take advantage of automatic 
backups.

If you wish to load the configurations from a VMS system (see Chapter 6), 
you must create a network drive to the OpenVMS directory.

 2.3.2  Procedure: Installing from the WWW
To install the configurator, follow these steps:

1. Create a temporary installation folder.

You can delete this folder once installation is complete.

2. Copy the clearVISN DECNIS Configurator kit to the temporary 
directory from its World Wide Web (WWW) location. You can find this 
location by going to:

PC software required • Windows NT V3.51 or higher, or 
Windows 95; Windows NT V4.0 for 
Alpha

• Microsoft TCP/IP network protocol 
stack (included with operating 
system)

• Driver for network adapter, or 
default operating system driver

Disk space required During installation: 55 Mbytes
During use: 25 Mbytes

(These figures include the 5 Mbytes 
occupied by the DECNIS image.)

DECNIS versions DECNIS 500 or 600. Management 
processors MPC-I, MPC-II, or MPC-III
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(USA) http://www.networks.digital.com/dr/cdc/index.html 

(Europe) http://www.networks.europe.digital.com/dr/cdc/index.html

(Australia) http://www.digital.com.au/networks/dr/cdc/index.html

3. Once you have copied the configurator to the temporary folder, run the 
following file in the temporary folder:

NISV300.EXE

4. The installation procedure asks you for a folder name for the 
configurator. The default name is C:\Program Files\Digital\RConfig.

5. The configurator then asks you for a location for the Clients directory. 
Enter the path name where the load files will be stored. If you wish to 
store the configurations on a remote system, specify the network drive 
that represents the directory on that system. (See Chapter 6 for 
information on storing the files on an OpenVMS system.)

This installs both the DECNIS V4.1 image and the configurator software.

 2.3.3  Procedure: Installing from CD-ROM
To install the configurator from the CD-ROM, follow these steps:

1. View the contents of the CD-ROM using File Manager or Explorer.

2. Run the file SETUP.EXE on the CD-ROM. 

3. The installation procedure asks you for a folder name for the 
configurator. The default name is C:\Program Files\Digital\RConfig.

4. The configurator then asks you for a location for the Clients directory. 
Enter the path name where the load files will be stored. Note that if you 
wish to load the configuration from an OpenVMS host, you should 
specify the network drive that represents the OpenVMS directory on 
which the load files will be stored. See Chapter 6 for more information.

This installs both the DECNIS V4.1 image and the configurator software.
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Chapter 3

Starting and Using the clearVISN DECNIS
Configurator

 3.1   Starting the Configurator

 3.1.1  Windows 95-style User Interface
From the Start menu, choose 

Programs Î Digital Configurators Î clearVISN DECNIS Configurator

 3.1.2  Windows 3.1-style User Interface
Double click the Digital Configurators program group. Then double click 
the clearVISN DECNIS Configurator icon.

 3.2   Using the Configurator  

This section describes the main elements of the configurator, and how to 
use them.

When you first start the configurator, the window shown in Figure 3-1 
appears. 

 3.2.1  The clearVISN Router Configurator Window
This window provides menus and toolbar buttons that allow you to 
manipulate the DECNIS configurations you have created, and to start 
associated utilities. It also contains the Browser window, which lists all the 
DECNIS configurations created so far.
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Figure  3-1: The Router Configurator Window and Browser

 3.2.2  Menu Bar and Toolbar  
You can select menu options from the configurator menu bar. Some of these 
menu options have shortcut buttons that appear on the toolbar. (To toggle 
between displaying and not displaying the toolbar, select Toolbar from the 
View menu.)

Some menu options are only available when a configuration is open. 

 3.2.3  Status Bar
The status bar displays information on the menu choice or toolbar button 
over which the cursor is positioned.

 3.2.4  Browser Window
This window lists all the DECNIS configurations created so far on the PC. 
If the clearVISN Router Configurator is also installed, the list includes any 
configurations created by that product.

Menu bar
Toolbar

Browser window

Configuration list

Status bar
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 3.2.5  Main Navigation Window
Figure 3-2 shows the main navigation window for a configuration.

Figure  3-2: The Main Navigation Window

This window appears when you open an existing configuration (by double 
clicking it in the Browser window) or create a new configuration.

Click the buttons on the left side of this window to configure the 
corresponding DECNIS functions.

 3.2.6  Tab Pages
Clicking on one of the buttons on the left side of the main navigation 
window causes a set of tab pages to appear, or a new window, depending on 
the button.
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For example, if you click on the IP Routing button, the set of tab pages 
shown in Figure 3-3 appears.

Figure  3-3: The IP Routing Tab Pages

Click on the appropriate tab to bring that tab page to the front.

The tab pages that are accessible depend on what options you have chosen. 
In the example in Figure 3-3, the three tab pages on the right are only 
available when you check the Route Propagation and Filtering box on 
the IP General tab page.

 3.3   Creating and Modifying Configurations

 3.3.1  Creating a New Configuration
1. Click the New button on the toolbar, or select New from the Router 

menu.

2. Enter the node name of the DECNIS, and the name of the 
configuration.

3. Select the hardware type. This is either DECNIS 500 or DECNIS 600.
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Note that, if the clearVISN Router Configurator V3.0 or later has also 
been installed, the list of hardware types will include products 
supported by that configurator.

4. If required, amend the path and name of the data file.

By default, this is taken from the information you supplied at 
installation. If you change this path, then all the files related to this 
configuration will be stored in the location you specify here.

5. Ignore the Software Version and License Option boxes; these relate 
only to the clearVISN Router Configurator.

6. If you are converting a configuration produced with the text-based 
OpenVMS, Digital UNIX, or MS-DOS configurator, check the Migrate 
From box. See Section 3.5 for more information.

Now, the main navigation window (see Section 3.2.5) opens for the 
configuration you have created. Create your configuration by clicking the 
appropriate buttons to configure the features you require.

 3.3.2  Modifying an Existing Configuration
In the Browser window, double-click on the configuration you wish to 
modify. Alternatively, select the configuration, and click the Modify 
button on the toolbar, or select Modify from the Router menu.

The main navigation window (see Section 3.2.5) opens for the configuration 
you wish to modify. 

 3.3.3  Copying a Configuration to Another DECNIS
This section describes how to copy a configuration from one DECNIS to 
another.

NOTE

You must amend some elements of the configuration once you have 
copied them, such as the hardware address, IP address, and so on. 
Otherwise your network may suffer serious problems.

To copy a configuration from one DECNIS to another, follow these steps:

1. In the Browser window, select the configuration you wish to copy. 

For example, you may wish to copy the configuration named Config for 
Hinksey associated with the router named Hinksey.
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2. Select Copy from the Router menu, or click the right mouse button and 
select Copy from the pop-up menu.

3. In the Copy Router Configuration dialog, enter the name of the router 
to which the new configuration will apply, for example, Botley.

4. By default, the new configuration name will be Config for Botley. 
Change this name if you wish.

5. Now open the configuration for Botley, and amend the configuration as 
required. Note that you must amend the hardware address, and any 
DECnet or IP addresses.

Using a Configuration Template

If you have a number of DECNIS systems, all of which have similar 
configurations, you can create a single, template configuration, and copy 
this to the DECNIS systems as required.

To do this, create a configuration that is applicable to all of the DECNIS 
systems. Note that this must omit addressing information, such as 
hardware address, IP addresses, and so on.

Now use the above procedure to copy this configuration to each of the 
DECNIS systems. Open each of the new configurations and add the 
missing information, and make any other changes required.

 3.4   Using Tools and Menu Options

The Router Configurator window provides a number of menus and tools. 
These allow you to start related utilities, and to manipulate existing 
configurations.

For example, to start the WinDTF utility (see Section 7.7), click the DTF 
button on the toolbar, or select Start DTF from the Tools menu.

To rename or delete a configuration, select the configuration in the 
Browser window and select the appropriate option from the Router menu. 
Alternatively, use the right mouse button to click on the configuration in 
the Browser window, and select the appropriate option from the popup 
menu.

For detailed information on tools and menu options, see the online help.
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 3.5   Migrating From OpenVMS, Digital UNIX, or MS-DOS 
Configurations

 3.5.1  Introduction
The  clearVISN DECNIS Configurator creates a configuration data file 
(.NIS). This file contains, in binary form, the information you have supplied 
to the configurator. It can be read and modified on any PC on which the 
clearVISN DECNIS Configurator has been installed.

The DECNIS clearVISN configurator cannot read a configuration data file 
created by any of the other, text-based, DECNIS configurators, that is, the 
OpenVMS, Digital UNIX, or MS-DOS configurator.

However, it can convert a configuration created by one of those 
configurators to the clearVISN DECNIS Configurator format. In this way, 
you can maintain and amend a configuration created on (for example) an 
OpenVMS system, without needing to maintain an OpenVMS host.

 3.5.2  Conversion Mechanism
The clearVISN DECNIS Configurator converts a configuration created by 
another, text-based, configurator by reading the NCL script file created by 
that configurator, and creating a configuration data file from the 
information it contains.

Section 3.9 describes NCL script files in more detail. See the DECNIS 
Management manual for a full description.

 3.5.3  Procedure
1. Follow the instructions in Section 3.3.1 for creating a new 

configuration. Ensure that you check the Migrate From box.

2. Insert the path name of the NCL script file that you wish to convert.

3. Click OK.

The clearVISN DECNIS Configurator first checks the NCL script file, to 
ensure that it contains valid NCL commands. It then attempts to create a 
configuration data file (.NIS) from the information contained in the NCL 
script file.

A message will inform you if either of these steps fails.

If the migration is successful, the main navigation window for the new, 
migrated, configuration will appear.
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 3.5.4  Restrictions

Migrating Unsupported Features

If the original configuration contained features that the clearVISN 
DECNIS Configurator does not support, the NCL commands to provide 
these features are placed in the Extra NCL tab pages (see Section 3.9). 

Types of NCL Script Files

Migrating a previous configuration is only supported if the original NCL 
script file was produced by one of the following configurators:

• OpenVMS

• Digital UNIX

• DECROU (PC DOS)

Problems are likely if the NCL script file created by one of the above 
configurators has been altered in any way.

 3.6   Importing Configuration Data Files

 3.6.1  Introduction
This section describes how to create a new configuration by importing a 
configuration data file (.NIS) into the configurator.

This is a useful method of importing a configuration created on another PC, 
or created using an earlier version of the clearVISN DECNIS configurator.

 3.6.2  Procedure
1. Select the .NIS file you wish to import.

2. Drag it to the Browser window if the configurator window is running, 
or to the Browser application file (COMMONBROWSER.EXE) if it is 
not running. Alternatively, double click the .NIS file. 

3. The Browser window will open (if necessary) and you will be asked if 
you want to change any of the default information about the new 
configuration, such as DECNIS name, configuration name, and so on.

4. Click OK to create the new configuration.

The main navigation window for the new configuration opens.

5. Change any required information for the new configuration.
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 3.6.3  Importing Several Data Files
In addition to dragging and dropping individual data files, you can drag 
and drop folders. These folders will be searched recursively for data files. 
You confirm individually each file to be imported.

 Also, you can drag and drop .MDB database files. The Browser window 
uses an .MDB file to create the list of configurations. When you drag and 
drop an .MDB file into the Browser window, all the files listed in that .MDB 
file are imported.

 3.7   Sections in the Configurator

Table 3-1 lists the sections in the configurator, with a brief explanation of 
each.

Table  3-1: Sections in the Configurator

Section Description

System Information on the DECNIS system, such as DECNIS name and 
hardware address, network management security, SNMP and event 
logging. Also information on load files.

Interfaces Which network interface cards are in which backplane slots, and 
which datalink protocols run on each port.

IP Routing Which circuits are enabled for IP routing. IP addressing. RIP and 
OSPF configuration. Route propagation and filtering. IP database 
sizing.

DNA IV and 
V/OSI

Which circuits are enabled for DECnet Phase IV and DECnet Phase 
V/OSI routing. DECnet addressing. DECnet database sizing.

IPX Which circuits are enabled for NetWare IPX routing. IPX tunnel 
circuits.

Bridging Which interfaces are configured as bridge ports. Bridge port 
configuration parameters. Address and protocol filtering.

X.25 X.25 routing circuits, server and relay clients, PVCs, X.25 reachable 
addresses, X.25 security.

Secure 
Connections

Secure connections access rules. See Chapter 4 for more information.

NCL Scripts NCL script automatically generated by the configurator (read-only). 
Also the extra NCL script files. See Section 3.9 for more information.
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 3.8   Entering Valid Information

When you click the OK button in a tab page or window, the configurator 
will check that the information you have added or modified is valid. If it is 
not, an error message will tell you what you need to do.

For example, if you open the System tab pages, and click OK without 
entering a hardware address, an error message will appear.

You can choose to ignore the errors at this stage. However, you cannot 
create the load files until you have corrected the errors.

When you click the Compile or Load button on the main navigation 
window, the configuration is checked. If there are configuration errors, a 
list will be displayed.

To create a loadable configuration, you must enter the following 
information:

• Hardware address

• A default IP address if the DECNIS will use IP 

• A DECnet Phase IV or Phase V address if the DECNIS will use DECnet 

 3.9   Entering Extra NCL Commands

The configurator automatically creates a configuration script of NCL 
commands, for the functions you can configure. However, you cannot use 
the configurator to set up all of the DECNIS functions. For example, you 
cannot use the configurator to set up AppleTalk routing, or to filter 
DECNIS events.

In order to set up functions not supported by the configurator, you need to 
add extra NCL commands on the Extra NCL tab pages.

See the DECNIS Management manual for a description of NCL and 
configuration scripts.

 3.9.1  Extra NCL Tab Pages
To view the NCL script that is automatically created by the configurator, 
click the  NCL Scripts button on the main navigation window, and select 
the Generated NCL tab page.
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The NCL section of the configurator includes the following tab pages:

 3.9.2  Procedure
Enter extra NCL commands by typing directly into the relevant tab page. 
You can use the keyboard and mouse for basic editing functions. In 
addition, you can copy, cut and paste using the Edit menu.

To import text files from another source, select the Insert option from the 
NCL menu.

When you have finished entering commands, select the Check option from 
the NCL menu. This validates the NCL script, including the extra 
commands you entered. Errors will be reported in a separate window.

 3.10   Using Help

To get help on a specific tab page or window, click the Help button on that 
window, or press the F1 key when the window is active.

To access the Help Contents, Index, or Find utility, choose the Help 
Topics option from the DECNIS Help menu, and select the appropriate 
Help tab page (Contents, Index, or Find). Alternatively, if the Help window 
is already open, click the Contents or Index button in the Help window.

Generated NCL The configurator generates an NCL 
script based on the information you 
supply in the various configurator 
sections. This tab page allows you to 
view this script.
You compile this NCL script into CMIP 
form by clicking the Compile or Load 
button on the main navigation window.

Extra CREATEs
Extra SETs
Extra ENABLEs

If you enter any NCL commands in these 
tab pages, the commands are also 
compiled into the CMIP script, in the 
appropriate locations.
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Chapter 4

Secure Connections

 4.1   Overview

This chapter describes the DECNIS Secure Connections utility, and how it 
protects networked computer systems.

 4.1.1  What Is Secure Connections?
Secure Connections is a utility that allows you to set up network filters on 
the DECNIS. These filters prevent or permit connections, according to a 
number of user-defined criteria, such as source node address, time of day, 
and so on. 

You specify the particular criteria you wish to use in a set of access rules. 
An access rule behaves like a filter, denying or permitting connections 
through the DECNIS, depending on whether they fit the criteria specified 
in the rule. See Section 4.2 for more information on access rules.

 4.1.2  Using Secure Connections in Your Network: Example
Figure 4-1 shows a network consisting of two divisions (Red and Blue), 
connected by a DECNIS. 

When Secure Connections is not configured on the DECNIS, each system 
in the network can communicate with any other system.

By configuring Secure Connections on the DECNIS, you can permit or deny 
connections that are routed through the DECNIS, based on a number of 
criteria.

Example 1: You could set up a filter that would permit systems in the Red zone
to access the Blue zone on weekdays during office hours, but deny access at 
all other times.

Example 2: You could set up a filter to prevent mail being sent between 
the two zones, except for mail between two named systems.
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Example 3: You could set up filters such that all IP traffic from the Red zone to t
Blue zone is prevented, while DECnet traffic is permitted.

Figure  4-1: Using Secure Connections in a Network

 4.1.3  Secure Connections and the Configurator
You must use the configurator to set up Secure Connections on the 
DECNIS. The configurator allows you to set up access rules for the 
DECNIS, compile the rules file, and download it to the DECNIS.

To set up access rules, click the Secure Connections button on the main 
navigation window. To compile the rules file and load it on to the DECNIS, 
click the Load button on the main navigation window.

CAUTION

Once you have loaded a Secure Connections configuration on the 
DECNIS, any connection that is not explicitly permitted, by a permit 
access rule, is denied. 

 4.2   Access Rules

 4.2.1  What Are Access Rules?
Access rules define all prohibited and permitted network activity through 
the DECNIS. Each access rule specifies that the DECNIS will permit or 
deny network traffic fitting a set of user-defined criteria.

You can specify three types of access rule:  IP, DECnet Phase V/OSI, and 
DECnet Phase IV.

DECNIS

Blue division Red division

B1

B2

B3

R1

R2

R3
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 4.2.2  IP Access Rules
Create IP access rules if you want your Secure Connections configuration 
to apply to IP traffic.

You can base an IP access rule on one or more of the following criteria:

• IP protocol

TCP, UDP, or ICMP. If you select ICMP, you can further specify those 
ICMP message numbers to which the rule applies.

• Destination and source IP address

• Destination and source port number (for TCP and UDP protocols only)

• Outgoing and incoming routing circuit names

• Days of the week and hours of the day

 4.2.3  DECnet Phase V/OSI Access Rules
Create DECnet Phase V/OSI access rules if you want your Secure 
Connections configuration to apply to DECnet Phase V/OSI traffic.

You can base a DECnet Phase V/OSI access rule on one or more of the 
following criteria:

• Destination and source NSAP

• Outgoing and incoming routing circuit names

• Days of the week and hours of the day

• Phase V application number or task name

• User name

 4.2.4  DECnet Phase IV Access Rules
Create DECnet Phase IV access rules if you want your Secure Connections 
configuration to apply to DECnet Phase IV Secure Connections traffic.

You can base a DECnet Phase IV access rule on one or more of the following 
criteria:

• Destination and source Phase IV address

• Outgoing and incoming routing circuit names

• Days of the week and hours of the day

• DECnet object number or task name
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• User name

 4.2.5  Permit and Deny Access Rules
You specify each access rule as a permit rule or a deny rule. A permit rule 
allows connections that fit the criteria specified in the rule. A deny rule 
prevents connections that fit the criteria.

Once you have loaded a Secure Connections file on the DECNIS, any 
connection that is not explicitly permitted, by a permit access rule, is 
denied. 

 4.2.6  Bidirectional Access Rules
You can specify that a rule is bidirectional. This means that the rule 
applies to network traffic in both directions. 

For example, you can set up a rule to prevent node A communicating with 
node B outside office hours. If you make this rule biderectional, you also 
prevent node B from communicating with node A outside office hours. This 
is easier than setting up a separate rule to achieve the same result.

 4.3   Groups of Attributes

 4.3.1  What Are Groups?
A group is a set of node addresses, circuit names, user names, and so on, 
that you can specify in access rules. For example, in Figure 4-1, if you want 
to prevent nodes B1 and B2 from communicating with the Red division, you 
could create a group of addresses consisting of the addresses of nodes B1 
and B2. When you create the access rule, you specify this group, rather 
than individual node addresses.

You can create groups of the following types:

• IP addresses

• IP routing circuits

• TCP/IP ports

• UDP/IP ports

• DECnet Phase V/OSI network addresses (NSAPs)

• DECnet Phase V/OSI routing circuits

• DECnet Phase V/OSI applications
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• DECnet user names

• DECnet tasks

• DECnet Phase IV addresses

• DECnet Phase IV circuits

• DECnet Phase IV objects

 4.3.2  Before You Start
Before you create groups of routing circuits (IP, DECnet Phase IV or 
DECnet Phase V/OSI), you must create the routing circuits in the 
Interfaces section and enable them for the appropriate routing protocol.

 4.3.3  Procedure
To create one or more groups for use in access rules, follow these steps:

1. Start the configurator, and open a new or existing configuration.

2. Click the Secure Connections button on the main navigation 
window.

3. Click the Configure Groups button on the Secure Connections 
window. Click the New button on the Configure Groups window, 
shown in Figure 4-2.

4. Select the type of group you wish to create in the Group Type field.

5. Select or enter the name of the first member of the group in the field 
below.

6. Click the Add button.

7. Repeat steps 6 and 7 until you have entered all the group members.

8. Click the OK button.
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Figure  4-2: The Configure Groups Window

You can now select the group you have created when you set up access 
rules. For example, instead of entering an IP destination address in an IP 
access rule, you can select the name of a group of IP addresses, and the rule 
will apply to all IP addresses in the group.
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 4.4   Creating a Secure Connections Configuration

This section describes the steps involved in creating a Secure Connections 
configuration for the DECNIS.

 4.4.1  Procedure
To create a Secure Connections configuration, follow these steps:

1. Start the configurator, and open a new or existing configuration.

2. Click the Secure Connections button on the main navigation 
window.

3. Click the New button on the Secure Connections window, shown in 
Figure 4-3.

Figure  4-3: The Secure Connections Window

4. Check the Default Rules Configuration box if you want this to be 
the default Secure Connections configuration that is loaded each time 
the DECNIS is loaded from the PC. 
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You can create a number of Secure Connections configurations, each 
with its own set of access rules. Only one can be loaded on the DECNIS 
at any time.

5. Check the Event Denied Connections box if you wish the DECNIS 
to generate an event each time a connection is denied because of this 
Secure Connections configuration.

6. Click the Configure Groups button if you wish to create groups that 
you can use in the access rules for this configuration. See Section 4.3 
above.

7. Check one or more of the Use IP Rules, Use Phase IV Rules, and 
Use Phase V/OSI Rules boxes, depending on which categories of rules 
you want to include in this configuration. 

Note that you can still configure rules even if you do not check the 
relevant box. These rules will form part of the Secure Connections 
configuration that is loaded on the DECNIS, but will not be activated 
initially. However, you can use NCL commands to activate them 
dynamically, at a later date.

8. To create access rules of a particular category for this configuration, 
click the appropriate button, IP, Phase IV, or Phase V/OSI. (The IP 
button will not be available if you have not selected to run IP in the 
System Settings tab page; the Phase IV and Phase V/OSI buttons 
will not be available if you have not chosen to run the DECnet 
protocols.)

This takes you to a set of tab pages.

9. Select the Create/Delete Rules tab page, and enter the appropriate 
information about the rule. 

10. Select other tab pages to enter further criteria for the rule.

11. Repeat steps 9 and 10 to enter further rules in this category.

12. Go back to the Secure Connections window, and click a button for a 
different category of rule, if required. Continue until you have created 
all the access rules in all the categories that you require.

 4.5   Testing Your Secure Connections Configuration

The configurator allows you to create tests to check the effects of your 
Secure Connections configuration on various types of traffic.

You can create tests for IP, DECnet Phase IV, and DECnet Phase V/OSI 
traffic. The configurator can then run these tests, and inform you if the 
Secure Connections configuration is operating as you intended.
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 4.5.1  Procedure
To test your Secure Connections configuration, follow these steps:

1. Start the configurator, and open the DECNIS configuration you 
require.

2. Click the Secure Connections button on the main navigation 
window.

3. In the Enter/Modify Tests part of the Secure Connections window, 
choose the type of traffic for which to create a test by clicking the 
appropriate button (IP, Phase IV, or Phase V/OSI).

This takes you to a window in which you can create one or more tests 
specific to that type of traffic. For each test, you specify traffic details. 
For example, for each IP test you can specify the following:

— IP protocol (ICMP, TCP, or UDP)

— Source and destination node, circuit, and port

— Day of the week and hour of the day

You also specify whether you expect the default Secure Connections 
configuration to permit or deny such traffic.

4. Click OK when you have created all the tests for that particular traffic 
type. 

5. Repeat the above step if you wish to create tests for other traffic types.

6. Click the Run Tests button on the Secure Connections window.

The configurator will then report on whether each test passed or failed, 
that is, whether your expected result in each test (permit or deny 
traffic) was correct.

 4.6   Viewing Your Secure Connections Configuration

Click the Rule Summary button on the Secure Connections window to 
display a text summary of the rules you have created. 

You can also import a text summary of your configuration into a Microsoft 
Access database. This allows you to manipulate the way in which the 
Secure Connections information is accessed, and is particularly useful for 
large and complex configurations.

To import a summary of your Secure Connections configuration, click the 
Rule Summary button on the Secure Connections window. This displays 
the Rule Summary window.
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Click the Export button on the Rule Summary window. This creates three 
files (one for each of the IP, DECnet Phase IV and DECnet Phase V/OSI 
rules), each of which consists of a text summary of the rules in the form of 
a semicolon-separated list.

You can then import these files into a Microsoft Access database. See the 
online help for step-by-step instructions on importing these files into 
Microsoft Access 97.

 4.7   Sharing a Secure Connections Configuration

Two or more DECNIS configurations can use the same Secure Connections 
configuration. To do this, you create a Secure Connections configuration 
using the configurator. All DECNIS configurations that wish to use this 
Secure Connections configuration can then link to it. 

Note that all configurations that share the same Secure Connections 
configuration must use the same circuit names.

Follow these steps to set up a shared Secure Connections configuration:

1. Start the configurator, and open the DECNIS configuration you 
require.

2. Click the Secure Connections button on the main navigation 
window.

3. Create a new Secure Connections configuration and enter rules as 
required.

4. Click the Save To button to save the Secure Connections configuration 
to a file. Note that this file must be accessible to all PCs that hold 
DECNIS configurations that wish to share it.

5. Click the Link To button, and specify the file you created in the above 
step.

Your Secure Connections configuration is now linked to that file. Any 
changes you make will be saved to the file each time you save your 
DECNIS configuration.

For other DECNIS configurations to use this Secure Connections 
configuration, they must create a new Secure Connections configuration, 
click the Link To button, and specify the file created in the above 
procedure.

The Secure Connections configuration can be changed by any DECNIS 
configuration that links to it. However, the file is locked when a DECNIS 
configuration is opened. Another machine/user will be unable to change 
4-10  Secure Connections



this Secure Connections configuration until the first DECNIS 
configuration is closed. However, if the same machine/user owns both 
configurations, the lock can be overridden. In this case, the first 
configuration to close will lose any changes it made to the linked 
configuration.

 4.8   Loading Your Secure Connections Configuration

This section describes how to create the Secure Connections rules file, and 
download it to the DECNIS.

You can load your Secure Connections rules file in two ways:

• By rebooting the DECNIS: the Secure Connections rules file is loaded 
along with all the other load files required by the DECNIS.

• Independently of the other load files: the Secure Connections rules file 
is loaded on the running DECNIS.

 4.8.1  Procedure: Rebooting the DECNIS
To create and load the Secure Connections rules file, together with all the 
other load files the DECNIS requires, follow these steps:

1. Start the configurator, and open the DECNIS configuration you 
require.

2. Click the Secure Connections button on the main navigation 
window.

3. Select the Secure Connections configuration that is to be loaded, and 
check the Default Rules Configuration box.

4. Click the OK button, and then click the Load or Compile button on 
the main navigation window.

This compiles the Secure Connections rules file into a form suitable for 
downloading to the DECNIS.

Clicking the Load button causes the DECNIS to reboot after the file 
has been compiled.

Clicking the Compile button merely compiles the file, ready for 
downloading when the DECNIS next reboots using the PC as a load 
host.
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 4.8.2  Procedure: Loading the Secure Connections Rules File 
Independently

The Secure Connections window has a Load Rules button. Clicking this 
causes the configurator to send an NCL command to the DECNIS, 
instructing it to issue a load request for the secure connections file. If the 
DECNIS is set up to load its Secure Connections rules file from Flash, it 
will simply reload from Flash.

If you wish to amend the Secure Connections configuration and load the 
amended version on the DECNIS without rebooting, you must ensure that 
the Secure Connections rules file is not contained in Flash. Use the Load 
Options tab in the System section of the configurator to specify that Flash 
does not contain the Secure Connections rules file.

Note that you can only load the Secure Connections rules file if the selected 
Secure Connections configuration is the Default Rules Configuration, and 
the DECNIS is manageable and reachable using the IP protocols.

To create and load the Secure Connections rules file independently of the 
other load files, and without rebooting the DECNIS, follow these steps:

1. Start the configurator, and open the DECNIS configuration you 
require.

2. Click the Secure Connections button on the main navigation 
window.

3. Select the Secure Connections configuration that is to be loaded, 
amend it as required, and check the Default Rules Configuration 
box.

4. Click the Compile Rules button.

This compiles the Secure Connections rules file into a form suitable for 
downloading to the DECNIS.

5. Click the Load Rules button. 

This causes the DECNIS to reload its Secure Connections rules file.
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Chapter 5

Loading the DECNIS

 5.1   Overview

This chapter describes how the DECNIS is loaded, and how to load the 
DECNIS using the configurator.

For a full description of the loading process, see the DECNIS Management  
manual.

 5.2   Load Files

When the DECNIS reboots, it loads the following files:

• System image

• Configuration (CMIP) file

• Secure connections configuration file

• Profile files

This section describes these files. 

 5.2.1  System Image
This is the DECNIS software. It is copied to the PC when you install the 
DECNIS kit.

 5.2.2  Configuration (CMIP) File
This is the binary version of the NCL configuration script created by the 
configurator. It reflects the information you have supplied about the 
configuration, as well as any extra NCL scripts you have created. It is the 
permanent configuration of the DECNIS. See the DECNIS Management 
manual for a description of NCL, configuration scripts, and CMIP.

To create the CMIP file, click the Compile button on the main navigation 
window when you have entered all the configuration information.
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You can view the NCL script from which the CMIP file is compiled by 
clicking the NCL Scripts button on the main navigation window. To create 
a file of the NCL script, go to the Generated NCL tab, and choose Export 
All NCL from the NCL menu.

 5.2.3  Secure Connections Configuration File
This file implements the secure connections configuration on the DECNIS. 
If you have not configured secure connections, or have not specified a 
secure connections configuration as the default, this file is not loaded.

 5.2.4  Profile Files
There are three profile files:

• The modem connect line profile file

• The X.25 Level 2 profile file

• The X.25 Level 3 profile file

These files are used to set various synchronous line and X.25 timers to their 
optimum values.

 5.3   Loading from Load Host or Nonvolatile Memory 
(Flash)

When the DECNIS reboots, it can load its files either from nonvolatile 
memory (Flash) or from a load host, depending on the value of  its 
Hardware Debug Flags NCL parameter.

You can use the configurator to determine whether the DECNIS loads from 
Flash or from the network. This information is encoded in the CMIP file 
that is loaded on the DECNIS.

You can also use the configurator to override what is in the CMIP file 
currently loaded on the DECNIS, and force it to load over the network: this 
is necessary when you want to load a modified configuration from the PC.

 5.3.1  Loading from a Load Host
If the DECNIS is set to load from a load host, it will load both its image and 
configuration (CMIP) file from the host.

You can use the configurator to configure the PC as a BOOTP load host.
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 5.3.2  BOOTP Load Host
A BOOTP load host responds to load requests from the DECNIS. 

A BOOTP load host must:

• Have a BOOTP database (a BOOTP.INI file), which lists the hardware 
addresses and corresponding IP addresses of all the DECNIS units 
that it can load. It also specifies the locations of the load files for each 
DECNIS.

• Have the required load files.

• Run the BOOTP server software. This listens for BOOTP requests from 
DECNIS units, and responds to those for which there is an entry in the 
PC’s BOOTP.INI file. 

You may wish to have the BOOTP server software always running on 
the PC by ensuring that it starts automatically each time the PC is 
rebooted.

 5.3.3  Loading from Flash
If the DECNIS is set to load from Flash, it will attempt to load the system 
image from there. If Flash does not contain a valid system image, the 
DECNIS will attempt to load the image from a load host on the network.

If the DECNIS successfully loads the system image from Flash, it will also 
load any other valid load files from Flash. If any load files are missing from 
Flash, it will attempt to load them over the network.

You can use the configurator to specify what files are loaded into Flash.

 5.4   Setting Up the PC as a BOOTP Load Host

This section describes how to use the configurator to set up the PC as a load 
host for a DECNIS. This allows the PC to respond to load requests from the 
DECNIS.

 5.4.1  Procedure
To set up the PC as a load host, follow these steps:

1. Start the configurator, open the configuration, and enter the 
configuration information for the DECNIS.

2. Click the System button on the main navigation window.

3. Click the Load Options tab page.
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4. Ensure that the load protocol selected is BOOTP.

5. Click the OK button.

6. Click the Compile button on the main navigation window.

The configurator validates the information you have supplied, and 
compiles it into CMIP format, suitable for loading on the DECNIS. In 
addition, it creates the secure connections rules file, if required, and 
may create a combined, compressed file suitable for loading into Flash, 
depending on the information you supplied on the Load Options tab 
page. 

A status window reports any errors in creating these files.

If all required files are successfully created, the configurator updates 
the PC’s BOOTP.INI file with information about the DECNIS. 

A boot icon next to the configuration in the Browser window indicates 
that the configuration is ready to be loaded.

7. Start the BOOTP server on the PC, by selecting Start BOOTP Server 
from the Tools menu.

If there are several configurations listed in the Browser window for the 
same DECNIS, you can select which of them will be loaded by clicking on 
the appropriate one with the right mouse button, and selecting Use 
BOOTP from the pop-up menu.

 5.5   Using the Configurator to Load a Configuration on the 
DECNIS

This section describes how to use the configurator to load a configuration 
on a DECNIS system.

 5.5.1  Procedure
To load a configuration on the DECNIS, follow these steps:

1. Start the configurator, and open the configuration you want to load.

2. Click the System button on the main navigation window.

3. Click the Load Options tab page.

4. Ensure that the load protocol selected is BOOTP.

5. Click the OK button.

6. Click the Load button on the main navigation window.
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A confirmation window appears.

7. Check the box labelled Force DECNIS to Load From Network.

This prevents the DECNIS from attempting to reload from Flash, and 
forces it to request a network load. 

8. Click OK.

If you have changed any configuration information since you last clicked 
the Compile button on the main navigation window, the configurator 
validates the information you have supplied, and compiles it into CMIP 
format, suitable for loading on the DECNIS. In addition, it creates the 
secure connections rules file, if required, and may create a combined, 
compressed file suitable for loading into Flash, depending on the 
information you supplied on the Load Options tab page. 

A status window reports any errors in creating these files.

If all required files are successfully created, the configurator starts the 
BOOTP server software on the PC (if not already running), and updates the 
PC’s BOOTP.INI file with information about the DECNIS.

The PC now attempts to send an NCL command to the DECNIS, 
instructing it to load its load files from the network when it next reboots.

If this command is successful, the PC sends the DECNIS a reboot 
command, and the DECNIS reboots. The PC responds to the BOOTP load 
request from the DECNIS, and the load files are loaded from the PC to the 
DECNIS.
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Chapter 6

VMS Load Host Support

 6.1   Overview

This chapter describes how to modify the installation procedure so that you 
can store the load files on an OpenVMS system, and then load that 
configuration, using MOP (Maintenance Operations Protocol), from that 
system.

 6.2   MOP Loading from an OpenVMS Host

 6.2.1  Requirements
The OpenVMS system must be running remote file mounting software 
(such as PATHWORKS™ or Samba), and must be configured as a MOP 
load host. See the appropriate OpenVMS networking documentation for 
information on configuring a MOP load host.

 6.2.2  Overview
Using an OpenVMS system as a MOP load host for a configuration created 
by the clearVISN DECNIS configurator requires the following:

1. The load files created by the configurator must be stored on the 
OpenVMS system. 

2. The load files must be converted to OpenVMS format.

3. The MOP client database on the OpenVMS system must be amended 
to include the DECNIS systems to be loaded.

The procedure below describes how to specify the location of the load 
clients, and how to use the supplied utility to convert the load files and 
update the MOP client database.

See the DECNIS Management manual for a description of loading the 
DECNIS using MOP.
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 6.2.3  Procedure
1. On the OpenVMS system, create a directory called DECROU that will 

be used to hold the required directories and associated VMS file 
utilities. 

2. Create a subdirectory of DECROU, called CLIENTS.

3. On the PC, connect a network drive to the OpenVMS DECROU 
directory. For example, H: \\Vmshost\Decrou.

4. Install the clearVISN configurator on the PC, as described in Section 
2.3. On the Choose Destination Location dialog, specify the 
CLIENTS folder of the network drive set up above, for example, 
H:\clients.

Note: This has the effect of placing the load files, by default, on the 
network drive. You can amend the location of the load files at any time 
by accessing the Load Files tab page of the configurator, under 
System.

5. Now copy the OpenVMS utility  (DECROU$DAEMON.COM) and 
associated files from the PC to the OpenVMS host. This utility converts 
the load files to OpenVMS format and updates the MOP client 
database on the OpenVMS host.

The files to be copied are in a subfolder of the installation folder called 
VMS. For example, if you installed the kit to C:\Program 
Files\Digital\RConfig, the files are in C:\Program 
Files\Digital\Rconfig\DECNIS\VMS. 

Copy the entire VMS folder to the network drive.

The network drive (for example H: \\Vmshost\Decrou) should now 
have two folders: \Clients and \VMS.

6. On the OpenVMS system, copy the following two files from the VMS 
folder to the Clients folder:

CVTCMIPA.EXE

CVTCMIPV.EXE

7. On the OpenVMS host, add an entry to SYSSTARTUP_VMS.COM to 
start the utility DECROU$DAEMON.COM automatically.

This ensures that the daemon is always running. It constantly checks 
for new and amended load files in any of the subdirectories of the 
CLIENTS directory, converting them and amending the MOP client 
database as required.

You can customize the DECROU$DAEMON utility as described in 
Section 6.2.5.

8. If you wish to load the DECNIS configurations before the OpenVMS 
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host is rebooted, run DECROU$DAEMON.COM from the command 
line.

9. Start the configurator on the PC, and enter the required information. 
On the Load Options tab page under System, ensure that the load 
protocol selected is MOP via VMS.

 6.2.4  Profile Files
If your configuration requires the profile files (see Section 5.2.4) and you 
have selected not to include them in the combined file, you must copy them 
manually to the OpenVMS host.

Copy them from the \Common subfolder of the installation folder (for 
example, C:\Program Files\Digital\RConfig\DECNIS\Common) to the 
MOP load directory on the OpenVMS host.

 6.2.5  The DECROU$DAEMON Utility
The DECROU$DAEMON utility is designed to run as a background 
process. It monitors the MOP data file (which you specify on the Load 
Files tab of the System section of the configurator) and converts/copies 
any new or amended load files listed there to the MOP load directory.

The DECROU$DAEMON.COM file is copied to the \VMS subfolder of the 
installation directory when you install the clearVISN DECNIS 
configurator. You copy this entire subfolder to the OpenVMS host as 
described above.

DIGITAL recommends that you start DECROU$DAEMON.COM by 
adding an entry in SYSSTARTUP_VMS.COM on the OpenVMS host, so 
that it starts when the host is booted, and runs continuously as a 
background process.

You can customize the operation of DECROU$DAEMON by changing the 
values of the logical names listed below:

DECROU$DAEMON_DECROU_ROOT

The name of the directory containing the CLIENTS and VMS 
subdirectories. The default is the parent directory of the VMS subdirectory 
(for example, DECROU).

DECROU$DAEMON_TARGET_DIRECTORY

The location of the MOP load directory, to which the converted image and 
CMIP files will be copied. The default is NIS$SYSTEM or, if not defined, 
MOM$SYSTEM.
VMS Load Host Support 6-3



DECROU$DAEMON_PERIOD

The number of seconds the daemon waits before checking for new or 
amended files in the CLIENTS subdirectory. The default is 30. If you set 
the value to 0, the daemon will exit after the first pass.

DECROU$DAEMON_TARGET_PREFIX

The prefix to be applied to all files that are copied to the target directory. 
For example, if you set this to NIS_, then the files NIS1.CMP and 
NIS1.SYS will be copied to the MOP load directory as NIS_NIS1.CMP and 
NIS_NIS1.SYS.

The default is no prefix.

DECROU$DAEMON_TARGET_SCRIPT_TYPE

The file extension for CMIP script files that are copied to the target 
directory. The default is .CMP.

DECROU$DAEMON_TARGET_IMAGE_TYPE

The file extension for image  files that are copied to the target directory. 
The default is .SYS.

DECROU$DAEMON_TARGET_SECCON_TYPE

The file extension for secure connections configuration files that are copied 
to the target directory. The default is .DAT.

DECROU$DAEMON_CVTCMIP

The file conversion procedure used to convert CMIP files to OpenVMS 
format. The default is DECROU$CVTCMIP.COM in the same directory as 
the daemon.

DECROU$DAEMON_CONFIGURE_MOP_CLIENTS

Whether or not the daemon creates MOP clients for the configurations 
found in the CLIENTS subdirectory. If this is set to YES, the daemon will 
issue NCL commands on the OpenVMS host to add the configurations to 
the MOP client database. 

Note that the process must have the required privileges to create MOP 
clients. If it is started from SYSSTARTUP_VMS.COM, it will have the 
required privileges.
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The default is NO.

DECROU$DAEMON_MOP_CIRCUIT

The name of the circuit on the OpenVMS host that will be used to load the 
MOP clients created by the daemon. You can only use one MOP circuit for 
loading these clients.

The default is FDDI-0.

DECROU$DAEMON_LOG

The location of the log file written by the utility. The default is 
SYS$OUTPUT.
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Chapter 7

Additional Configurator Utilities

 7.1   Overview

This chapter describes the following utilities that are part of the 
configurator:

• BOOTP Server

• NCL

• Address Mapper

• Mod_flsh

• Telnet

• WinDTF

• Event Monitor

You can access these utilities by selecting the appropriate option from the 
Tools menu.

 7.2   BOOTP Server

The BOOTP Server is a program that enables the PC to act as a BOOTP 
and TFTP server.

 7.2.1  BOOTP/TFTP Loading Process
When the DECNIS reloads from a load host, it first sends a BOOTP 
request, asking for its IP address. 

If  the BOOTP server is running on the PC and it receives the BOOTP 
request, it compares the hardware address contained in the request with a 
list of hardware addresses stored in its BOOTP database. If the database 
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has an entry for that hardware address, the PC sends the DECNIS a 
BOOTP response containing the IP address of the DECNIS, and the names 
of the load files.

The DECNIS then sends the PC a TFTP request for the named files. The 
PC responds to this by loading the files specified.

 7.2.2  Starting the BOOTP Server
To start the BOOTP server on the PC, select the Start BOOTP Server 
option from the Tools menu. The BOOTP server window will appear 
(iconified, by default).

Alternatively, you can start the BOOTP server independently, outside the 
configurator:

Windows-95 style user interface

From the Start menu, choose:

Programs ÎÎDigital Configurators ÎÎclearVISN BOOTP Server 

Windows 3.1-style user interface

Double click the Digital Configurators program group. Then double click 
the clearVISN BOOTP Server  icon.

 7.2.3  Adding an Entry to the BOOTP Database
To add an entry for a DECNIS to the PC’s BOOTP database,  start the 
configurator and open the appropriate configuration. Check the Set Up 
BOOTP Loading From This Host box on the Load Options tab page, 
click OK, and then click the Compile or Load button on the main 
navigation window. 

This starts the BOOTP server on the PC, if it is not already running, and 
updates BOOTP.INI, so that the PC can respond to BOOTP requests from 
that DECNIS.

See Chapter 5 for more information about setting up the PC as a load host.
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 7.2.4  The BOOTP Server Window
Figure 7-1 shows the BOOTP Server window that appears when you start 
the BOOTP server.

Figure  7-1: The BOOTP Server Window

This window reports BOOTP requests received by the PC, and the PC’s 
response.

Uncheck the BOOTP Enabled box to prevent the PC from listening for 
BOOTP requests. This prevents the DECNIS from learning its IP address 
and the names of its load files from the PC.

Uncheck the TFTP Enabled box to prevent the PC from sending the load 
files to the DECNIS.

Under normal circumstances, when the PC is configured as a BOOTP load 
host, both of these boxes should be checked. 
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 7.3   NCL

 7.3.1  What Is NCL?
NCL (Network Control Language) is a command line interface used to 
monitor and manage the DECNIS.

The configurator creates an NCL script that it then compiles to CMIP form 
for loading to the DECNIS. This constitutes the permanent configuration 
for the DECNIS.

However, you can also issue NCL commands to the DECNIS interactively, 
to change its behavior while it is running. Any configuration changes you 
make interactively are lost when the DECNIS is next rebooted.
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 7.3.2  Starting NCL from the Configurator
To start NCL on the configurator, select the Start NCL option from the 
Tools menu or click the NCL button on the tool bar.. The NCL window 
appears, as shown in Figure 7-2.

Figure  7-2: NCL Window

Alternatively, you can start NCL independently from the configurator:

Windows-95 style user interface

From the Start menu, choose:

Programs ÎÎDigital Configurators ÎÎclearVISN DECNIS WinNCL

Windows 3.1-style user interface

Double click the Digital Configurators program group. Then double click 
the clearVISN DECNIS WinNCL  icon.
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 7.3.3  Using NCL in the Configurator
To send an NCL command to a DECNIS, enter the command in the NCL 
Command field.  For example:

show node tester routing circuit l601-4-0

You can cut, paste, and copy within this field, by choosing the appropriate 
Edit menu options or toolbar buttons.

Click the scroll button to the right of this field to display other commands 
you have used in this session.

If you wish to send a series of commands to the same DECNIS, click the 
Default button. This lets you enter the IP address or name of the DECNIS, 
together with the network management user name and password, as set up 
in the Security tab page of the System Settings section. Every NCL 
command you enter subsequently will be sent to that node.

Note that if you use a node name instead of an IP address, there must be a 
suitable name server running in the network, and appropriate client 
software on the PC.

The output of the NCL command is displayed in the NCL Output field. 
You can copy from this field to the NCL Command field by  choosing the 
appropriate Edit menu options or toolbar buttons.

 7.3.4  Displaying NCL Help
The NCL utility includes a Microsoft Windows-style help file, that provides 
information on NCL commands.

To display this help when the NCL window is open, select Help Topics 
from the Help menu, and choose NCL Command Help from the Contents 
tab.

To display the help outside the configurator:

• Windows 3.1-style interface

Double click the NCL Command Help program item in the Digital 
Configurators program group.

• Windows 95-style interface

From the Start menu, choose:

Programs ÎÎDigital Configurators ÎÎNCL Command Help
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 7.4   Address Mapper

 7.4.1  What Is Address Mapper?
Address Mapper is a utility that allows you to associate node names with 
DECnet Phase IV or DECnet Phase V/OSI addresses. These node names 
are then available for selection, in any configuration,  wherever the 
configurator requires you to identify a DECnet node.

 7.4.2  Example
You have a DECnet Phase V/OSI node in your network called 
Org:.north.sales, with an address 37:231499500156:00-A5:08-00-2B-B2-
20-D0:20. You want this node to act as the event sink for all the DECNIS 
systems in the network.

To do this, start Address Mapper and enter the node name and address. 
Now, on the Event Logging tab page of each DECNIS configuration that 
you open, you can simply select the node name Org:.north.sales, instead of 
entering the address each time.

 7.4.3  Using Address Mapper
To use Address Mapper to enter node names and addresses, start the 
configurator and select Address Mapper from the Tools menu. 
Alternatively, click the Address Mapper button on the Event Logging tab 
page of any DECNIS configuration.
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The Address Mapper window appears, as shown in Figure 7-3.

Figure  7-3: Address Mapper Window

See the online help for detailed information on using this window.

 7.5   Mod_flsh

 7.5.1  What Is Mod_flsh?
The Mod_flsh utility allows you to view and modify the contents of the 
combined load file. This is the compressed file that is loaded into Flash. 
When the DECNIS is rebooted from Flash, it loads this file.

The Load Options tab page allows you to specify the contents of the 
combined load file. The combined load file can contain the following, 
depending on what you have selected on the Load Options tab page:

• System image

• CMIP script

• Secure connections rule file

• Modem connect profile file
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• X25 level 2 profile file

• X25 level 3 profile file

Mod_flsh allows you remove files from the combined file, or replace them 
with newer versions.

 7.5.2  Using Mod_flsh
To use Mod_flsh, start the configurator, open a configuration, and select 
Mod_flsh from the Tools menu. Alternatively, you can start it when you 
click the Load button on the main navigation window: the Load Status 
window contains a Modify Image button. Click this to start Mod_flsh.

An MS-DOS window will open in which Mod_flsh will run. Enter h  to see 
a list of commands. Enter q to quit Mod_flsh.

Note: If you have opened a configuration that does not have a combined file 
(for example, if you chose Load from Network on the Load Options tab 
page), an error will result.
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 7.6   Telnet

 7.6.1  What Is the Telnet Utility?
The Telnet utility starts the Windows Telnet application, and attempts to 
connect to the DECNIS whose configuration window is active.

You use the Telnet utility to connect to the DECNIS console from the PC. 
You can then enter console commands, for example, to boot and dump the 
DECNIS, start NCL. See the DECNIS Management manual for a 
description of DECNIS console commands.

 7.6.2  Using the Telnet Utility
To use the Telnet utility, start the configurator, open a configuration, and 
select Telnet from the Tools menu. 

The Telnet window opens, and an attempt is made to connect to the 
DECNIS. If the attempt is successful, you will see the console>  prompt. 
You will see an error message if you cannot connect to the DECNIS.
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 7.7   WinDTF

 7.7.1  What Is WinDTF?
DTF (Digital Trace Facility) is a utility that allows you to trace packets as 
they traverse the protocol layers of certain DIGITAL routers. WinDTF is a 
Windows-based version of this utility.

DIGITAL routers supported are:

• RouteAbout family and DECswitch 900EF

• DECNIS 500/600

• WANrouter 90/250

• VNswitch 900 family

The routers must be configured to run the TCP/IP protocol.

You can use WinDTF to trace data in real time, or to collect data for later 
analysis. 

 7.7.2  Starting WinDTF
To start  WinDTF on the PC, select the Start DTF option from the Tools 
menu. TheWinDTF window will appear, as shown in Figure 7-4.

Alternatively, you can start WinDTF independently from the configurator:

Windows 95-style user interface

From the Start menu, choose:

Programs ÎÎDigital Configurators ÎÎclearVISN WinDTF 

Windows 3.1-style user interface

Double click the Digital Configurators program group. Then double click 
the clearVISN WinDTF  icon.
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Figure  7-4: WinDTF Window

 7.7.3  Using WinDTF
To use WinDTF, you must first configure the trace. To do this, you specify 
the router you wish to trace, the tracepoints on that router, and details of 
how you want the trace records to be output. WinDTF then attempts to 
make a TCP/IP connection to the router, and instructs the router to send 
back trace records from the tracepoints specified.

See the online help for WinDTF for more information on using WinDTF. 
See the DTF User Guide for more information about tracing concepts.
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 7.8   Event Monitor

 7.8.1  What Is Event Monitor?
Event Monitor is a utility that allows a PC to act as an event sink for 
DECNIS systems. 

 7.8.2  Starting Event Monitor
To start  Event Monitor on the PC, select the Start Event Monitor option 
from the Tools menu. The Event Monitor window will appear, as shown in 
Figure 7-5.

Alternatively, you can start Event Monitor independently from the 
configurator:

Windows 95-style user interface

From the Start menu, choose:

Programs ÎÎDigital Configurators ÎÎclearVISN DECNIS Event 
Monitor

Windows 3.1-style user interface

Double click the Digital Configurators program group. Then double click 
the clearVISN Event Monitor icon.

The Event Monitor window opens.
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Figure  7-5: Event Monitor Window

 7.8.3  Using Event Monitor
DECNIS events are logged both to the Event Monitor window and to the 
file Events.txt in the installation directory.

Note that some text editors may prevent you from viewing the file if it is in 
use. If this is the case, copy the file and view the copy.

Uncheck the Display Events box in the Event Monitor window to prevent 
events being logged to the display. However, events will still be logged to 
the file.

Prerequisite

You must first configure one or more DECNIS systems to log events to the 
PC, by entering the IP address of the PC in the Event Logging tab in the 
System section of the configurator.
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